# Table of Contents

1 Introduction ................................................................................................................................. 5
   1.1 System Generation (SG) ........................................................................................................... 5
   1.2 UPID (Unique Parameter ID) ................................................................................................... 5
   1.3 PnP (Plug and Play) ............................................................................................................... 5

2 Overview ......................................................................................................................................... 7
   2.1 Tool button bar ....................................................................................................................... 7
   2.2 Menu ........................................................................................................................................ 8
      2.2.1 File .................................................................................................................................. 8
      2.2.2 Search ............................................................................................................................. 9
      2.2.3 Drive .............................................................................................................................. 9
      2.2.4 Services .......................................................................................................................... 9
      2.2.5 Options .......................................................................................................................... 9
      2.2.6 Window .......................................................................................................................... 10
      2.2.7 Tools ................................................................................................................................ 10
      2.2.8 Manuals ........................................................................................................................ 10
      2.2.9 Help ................................................................................................................................ 10
      2.2.9.1 Update Functions ...................................................................................................... 11
   2.3 Control Panel ........................................................................................................................... 11
   2.4 Messages .................................................................................................................................. 12
   2.5 Errors ....................................................................................................................................... 12
   2.6 Oscilloscope ............................................................................................................................ 13
   2.7 Curves ...................................................................................................................................... 14
   2.8 Parameters ............................................................................................................................... 15
   2.9 Variables ................................................................................................................................... 16
   2.10 Command Table ..................................................................................................................... 18
   2.11 Access Codes ......................................................................................................................... 18
   2.12 Information Window .............................................................................................................. 22

3 Quick Start Guide .......................................................................................................................... 22
   3.1 Cabling E1100 .......................................................................................................................... 23
   3.2 Cabling E1200 .......................................................................................................................... 24
   3.3 Cabling E1400 .......................................................................................................................... 25
   3.4 Cabling B1100 .......................................................................................................................... 26
   3.5 Cabling B8050-ML ..................................................................................................................... 27
   3.6 Cabling A1100 .......................................................................................................................... 28
   3.7 Cabling C1100 .......................................................................................................................... 29
   3.8 Cabling C1200 .......................................................................................................................... 30
   3.9 Cabling M8000 .......................................................................................................................... 31
   3.10 Firmware Download ............................................................................................................... 32
   3.11 Login ..................................................................................................................................... 32
   3.12 Downloading Older releases ................................................................................................. 33
      3.12.1 Manual Downloading .................................................................................................... 34
      3.12.2 Downloading by login ................................................................................................... 35
   3.13 Scanning CAN Bus .................................................................................................................. 35
   3.14 Scanning Ethernet ................................................................................................................... 36
   3.15 Motor Wizard ........................................................................................................................... 37
      3.15.1 Actuator Selection ......................................................................................................... 37
      3.15.2 Drive Settings ............................................................................................................... 39
1 Introduction

The LinMot-Talk 6 software is a PC based tool, which helps the user in a comfortable way installing firmware on the drive, setting up the drive's configuration, defining and programming motion profiles, emulating the PLC, watching variables and reading messages and errors. The LinMot-Talk 6 works with the drive series A1100, B1100, C1100, E1100, C1200, E1200, E1400 and B8050. It replaces the LinMot-Talk 1100 software. For the rest of this document and all other documents, the more general term “LinMot-Talk” will be used for the Linmot-PC configuration software. Information about software compatibility of LinMot-Talk 6 can be found under this Link. This Manual is for the LinMot-Talk version 6.10. If you have another LinMot-Talk version, it is possible that some features are different than they are described in this manual.

1.1 System Generation (SG)

The LinMot drive families are based on different hardware platforms, which are called system generations. The abbreviation is “SG”. Whereas differences of hardware of software functionality exist between the system generations, the documentation is marked with the “SG” term. The following table gives an overview of which drive family belongs to which SG:

<table>
<thead>
<tr>
<th>SG</th>
<th>Drives</th>
</tr>
</thead>
<tbody>
<tr>
<td>SG1</td>
<td>Families E400, E4000 V1 (not supported by LinMot-Talk 6)</td>
</tr>
<tr>
<td>SG2</td>
<td>Families E400, E4000 V2 (not supported by LinMot-Talk 6)</td>
</tr>
<tr>
<td>SG3</td>
<td>Family E1100 (GP, CO, DN, DP) (LC/HC/XC)</td>
</tr>
<tr>
<td>SG4</td>
<td>Family B1100 (VF, PP, GP, ML) (LC/HC/XC)</td>
</tr>
<tr>
<td>SG5</td>
<td>Family E1200 (GP, DP, DS, EC, IP, LU, PL, PN, SC, SE)</td>
</tr>
<tr>
<td></td>
<td>Family E1400 (GP, DP, DS, EC, IP, PD, PL, PN, SC, SE) (0S/1S)</td>
</tr>
<tr>
<td></td>
<td>Family B8000-ML (GP, EC, IP, PL, PN, SC)</td>
</tr>
<tr>
<td>SG6</td>
<td>Family C1250 (CC, CM, DS, EC, IP, LU, PD, PL, PN, SC, SE) (0S/1S)</td>
</tr>
<tr>
<td></td>
<td>Family E1400V2 (GP, DP, DS, EC, IP, LU, PD, PL, PN, SC, SE) (0S/1S)</td>
</tr>
<tr>
<td>SG7</td>
<td>Family A1100</td>
</tr>
<tr>
<td></td>
<td>Family C1100 (GP, DS, EC, PD, PN, SE) (0S/1S)</td>
</tr>
</tbody>
</table>

1.2 UPID (Unique Parameter ID)

All parameters have an assigned identification number, which is called a UPID (Unique Parameter ID). All parameters are accessed on the drive over this identification.

1.3 PnP (Plug and Play)

The drive families A1100, C1100, C1200, E1200 and E1400 support the so called „Plug and Play“ functionality. When a motor is connected to the drive, the motor will be automatically detected and the parameters will be set accordingly. The drive then can control the motor without any further configuration procedure. When starting the motor wizard, the connected motor is already selected and all the further configuration, such as exact slider, moving mass, friction etc can be set up. All components (drives and motors) which support the plug and play functionality are marked on the type label with “PnP”. The drive startup sequence is the following:
*) All parameters, which are set by the previous PnP motor and do not exist in the new motor will be set to default values prior to load the new parameters.
### 2 Overview

The most used functions after a start of the LinMot-Talk software is **Install firmware** or **Login to a drive**. The following screenshot gives an overview of the different functions integrated in the LinMot-Talk software. The Configuration and Setup Tools, the Drive Selection and the Shortcuts to Tools are in the **tool button bar**. In the **control panel** are the Control/Status Window, the IO Panel, the Motion Command Window and the Monitoring Window. More functions and setup possibilities are in the **Menu**.

#### 2.1 Tool button bar

The tool button bar is always present and consists of the following buttons (from left):

- **Show/Hide Tree** shows or hides the project tree window.
- **Up** sets the focus in the project tree to the parent of the selection.
- **Toggle** toggles between the last two displayed tree branches.
- **Import Configuration** imports configurations to the drives.
- **Export Configuration** exports configurations. Different drives and parts, such as parameters, variables, oscilloscope or curves, can be selected to be exported.
- **Print** prints items like curves, parameter configurations etc.
- **Install Firmware** Start the drive’s firmware installation.
- **Open Login** login to all drives in the selected workspace.
- **Save Login** save the actual workspace.
Reboot restarts the firmware on the drive.
Stop stops the firmware on the drive, used for downloading and configure the software.
Blink sends a blink LED command to the drive, which is selected.
Default: Parameters can be defaulted by instances. With this button, the default parameter procedure is started. A window will be shown where the instances (OS, MC, INTF and APPL software) can be selected. All parameters of the selected instances will be set to their default value.
Go Offline logs out from actual drive.
Start Motor Wizard starts the motor configuration setup wizard.
Show Control Panel switches to the control panel.
Show Parameters switches to the variables.
Show Variables switches to the variables.
Show Oscilloscope switches to the oscilloscope.
Show Messages switch to the message viewer.
Show Errors switches to error viewer.
Show Curves switches to the curve tool.
Show Command Table switches to the command table editor.
Show Object Inspector displays a window in which shows help information to each selected object.
Shows one decimal place more, for numbers like variable values. This button is only activated when the option "Round the decimal places" is activated.
Shows one decimal place less, for numbers like variable values. This button is only activated when the option "Round the decimal places" is activated.
Activates the Information Window. This window will be showed on the bottom of the LinMot-Talk when there is a message inside and it is activated.

2.2 Menu

In the menu there are a lot of functions and setup possibilities. They are separated in the following chapters: File, Search, Drive, Services, Options, Window, Tools, Manuals, Help.

2.2.1 File

In the Menu File are the following Commands.
- Login / OpenOffline... opens the window to login into a drive, or generate a offline drive with the help of a configuration file.
- Create Offline... creates an offline Drive with the default configuration.
- Scanning (with CANusb) scans the CANusb board for a Drive, works only with a CANusb board. See Scanning CAN Bus.
- Scanning (via Ethernet) can scan the Ethernet an makes a list with the drives, see scanning Ethernet.
- Logout logs out from the active drive.
- Import... imports a configuration from a lmc File, see import Configuration.
- Save All saves the configuration of the drives, see export Configuration.
- Save Login saves the ports over them LinMot-Talk is logged in at the moment.
- Open Login opens the Iws-File an try to login to all the drives.
- Print it is possible to Print some informations for example print the parameters or variables.
- Install Firmware starts the process to install firmware on a drive, see Firmware download.
- New opens a new LinMot-Talk Window
- Exit close the active window when it is the last window it shutdown LinMot-Talk
2.2.2 Search

In the Menu Search are the following Commands.

- **Find with UPID**... looks for parameter or variable with the UPID is typed in to the edit box.
- **Find with Caption**... looks for parameter or variable with the caption is typed in to the edit box.

2.2.3 Drive

In the Menu Drive are the following Commands.

- **Reboot**... restarts the firmware on the drive.
- **Stop**... stops the firmware on the drive, used for downloading and configure the software.
- **Blink** sends a blink LED command to the active drive.
- **Download**
  - **Software** it is possible to download single software parts manuel.
  - **Configuration** downloads a gr3 files to default the parameters.
- **Export Raw Data**... exports raw data of the configuration into a .pvl file.
- **Create UPID List**... is only used with a B1100, generates a list of UPIDs ander Master UPIDs of the parameters and variables.
- **Set Access Code**... is to enter the access code to activate special features, see Access Codes.
- **Save Config To SD-Card** saves the configuration on the SD Card, works only with a drive that has a SD Card slot.
- **Motor Wizard**... opens the Motor Wizard see in Motor Wizard.
- **Compare Parameter** allows to compare the settings between different drives, see Compare Parameters.
- **Advanced Save** saves a configuration in a format that could be open with a older LinMot-Talk (6.4 and older).

2.2.4 Services

In the Menu Service are the following Commands.

- **Show Control Panel** opens the Control Panel view, see in Control Panel.
- **Show Parameters** opens the Parameter view, see in Parameters.
- **Show Variables** opens the Variables view, see in Variables.
- **Show Oscilloscope** opens the Oscilloscope view, see in Oscilloscope.
- **Show Messages** opens the Messages view, see in Messages.
- **Show Errors** opens the Error view, see in Errors.
- **Show Curves** opens the Curve view, see in Curves.
- **Show Command Table** opens the Command Table view, see in Command Table.
- **Show FS Par Validation** opens the Functional Safety Parameter Validation, is only present when the active Drive is a 2S Drive.

2.2.5 Options

In the Menu Options are the following Commands.

- **Language** sets the language of LinMot-Talk. English, German and Italian are possible. If there is no translation the English text is showed.
- **UPID Display Mode** sets every where in the LinMot-Talk the UPID Display Mode. The following options are available Hexadecimal (the UPIDs are displayed in hexadecimal and have a "h" at the end) and Decimal.
- **Raw Data Display Mode** sets the Display Mode of the raw data of parameters and variables. The following options are available Hexadecimal and Decimal.
- **Exit Warning** is showed if an active device exists and the last window of LinMot-Talk will be closed. With Hide, the warning will not be displayed.
- **Set Login Timeout** opens a window where the timeout of the LinMot-Talk communication could be set. For values < 2s it has only influence to the login. For values > 2s the influence is on all the communication timeouts.
- **Save Debug Window Data** the LinMot-Talk saves the communication in a ring buffer, with this option it is possible to deactivate this.
- **Round the decimal places** by activate this option, LinMot-Talk rounds the numerical values to a defined number of decimal places. With the buttons in the tool button bar the defined number of decimal places could be changed.
- **Modulefunction** in the tree view LinMot-Talk displays drives as a module when they are connected to a motor module. By deactivate this option LinMot-Talk displays every drive as a single drive.
- **Motor Data Folder** when LinMot-Talk is installed over the setup, it saves the Motor files and the Firmware files into the AppData folder. If LinMot-Talk is copied from a zip-file, it will save this data in the folder where the program is. With this option it is possible to change this settings. This change has only an effect after a restart of LinMot-Talk!

### 2.2.6 Window

In the menu window is a list of all the LinMot-Talk windows. Set one window active by clicking on its item in the list.

### 2.2.7 Tools

In the Menu Tools are the following Tools.
- **LinRS Test Tool** opens a window where the LinRS communication can be tested. For more information see in the LinRS documentation (0185-1082).
- **CAN Talk Manager** opens the CAN Talk Manager. There are CAN Settings possible.
- **RSTalk Debug Window** open the communication debug Window, it shows the communication between the LinMot-Talk and the drives, see in Communication debug Window.
- **Read Drive** opens a window, it can read out the the correction tables from the drive.
- **Process Monitoring** opens a window to configure the process monitoring. Is only active when the process monitoring application is installed on the active drive. For more informations see in the Process Monitoring documentation (0185-1172).

### 2.2.8 Manuals

In the Menu Manuals are the following commands.
- **Parameter and Variables** generates a HTML page with a description of all parameters and variables of the selected part in the active drive. If the HTML is empty, then the selected part is not installed on the active drive.
- **Errors** generates a HTML page with a list of all errors of the selected part in the active drive. If no HTML page will be generated the selected part is not installed on the active drive.
- **Motion Commands** generates a HTML page with a list of all Motion Commands for the installed Motion Control software on the active drive.
- **Relevant Documents** gives a list of the relevant documents for the active drive. is are pdf documents.
- **All Documents** shows a list of all the pdf documents they are supplied with LinMot-Talk.

### 2.2.9 Help

In the Menu Help are the following commands.
- **Show Object Inspector** is inactive.
- **Home Page** opens the LinMot home page [www.linmot.com](http://www.linmot.com).
• **Update Functions** has a lot of subcommands, see in the sub-chapter **Update Functions**.

• **Default LinMot-Talk Settings** LinMot-Talk saves some settings like the language, this command set all this setting to the default values.

• **About LinMot-Talk 6.10** shows a window with informations about LinMot-Talk, like the build information.

### 2.2.9.1 Update Functions

In the Menu Update Functions are the following commands.

• **Check for Updates** LinMot-Talk looks at the home page, if there exists a newer version of LinMot-Talk.

• **Check for Software Updates at Program Startup** when this option is active, LinMot-Talk makes the Check for Updates at every startup.

• **Download and show News** LinMot-Talk download a news file from the home page and show this LinMot News in a window.

• **Check for News Updates at Program Startup** when this option is active, LinMot-Talk makes the Download and show News command at every startup.

• **Check for new Motor Files** starts the process to check on the server / local path if there are new motor files, see **Update motor files**.

• **Download Older Releases** starts the process to download older releases from the server / local path, see **Downloading Older releases**.

• **Generate Portable App** copies the LinMot-Talk files into a folder. The data in the folder gives a runnable application. See **Portable App**.

• **Update Option** the update function for motor files and older releases works normally over the update server of Linmot. If this is not possible there is a possibility over a local path. By this option is selected if the update goes over a local path or over the Linmot server, see **Problems with the updates function**.

### 2.3 Control Panel

The Control Panel helps the user to access directly to the control and status word of the MC Software. The drive can be commanded from the PC, thus no PLC is necessary to be used for the first commissioning.
- **Control Word** The MC software’s control word can be directly written from the PC. For taking over the PC control the left check box (Enable Manual Override) must be selected. The state of each flag can be set with the right check box (Override Value). If other flags have to be altered, the override mask must be configured in the parameter tree under Parameters\Motion Control SW\State Machine Setup\Control Word\Ctrl, Word Parameter Force Mask.

- **Status Word** The status word shows the actual state of the drive’s MC software status word. It is updated automatically.

- **General Monitoring** This window displays actual motor and drive information

- **Additional Variables** In this window variables could be chosen, then they are shown in the list and would be updated automatically.

- **IO Panel** For commissioning. The user can take control of the X4 IOs on E1100 or X14 IOs on B1100 drives.

- **Motion Command Interface** The MC software’s motion command interface can be directly accessed over this window. When enabled (Enable Manual Override switch must be set), MC commands can be selected, parametrized and sent to the drive. Because the motion command interface is independent of the interface running on the drive, the same, the commands can be exactly tested before programming them in the PLC.

### 2.4 Messages

This panel reads out and shows all messages, which are logged on the drive, and displays them in chronological order. If logged in a B1100 series drive, this window does not appear, because those drives do not support message logging. To get some informations about a message, select the message and press F1, the object inspector will show some information about the selected message.

### 2.5 Errors

This panel reads out and shows all errors, which are logged on the drive and displays them in chronological order. Install new firmware will logged because it is interesting if the error was before or after installing a new firmware.
To receive more information about an error, select the error and press F1, the Object Inspector will show some information about the selected error. It is possible to get the information about all errors by generating an error list under Manuals -> Errors. The error list is a HTML document and will open in a browser. There are error lists for every software layer. Therefore it is important to have a look on the source of an error. The source symbolises the layer where the error is explained.

2.6 Oscilloscope

The drive’s built-in oscilloscope, which can record up to eight channels in real time, is controlled with the oscilloscope tool.
During login the oscilloscope reads out the settings and data from the drive. If an oscilloscope shot is running or ready to read out data, an item called “Read out” will be displayed. Otherwise a default item will be generated.

The oscilloscope is controlled with the buttons

- **Start/Abort** Start or abort an oscilloscope shot. The button changes the symbol. Abort the actual record.
- **Abort** Abort the continuous mode and stop after the next record.
- **Fit View** Displays the recorded channels such as they fit best in the scope window.
- **Fit View (same unit same fit)** Displays the recorded channels such as the channels with the same unit have the same scaling and offset.
**Save Display** stores the settings for zoom, scaling and offset.

**Recall Display** restores the settings for zoom, scaling and offset, which are previously stored with Save Display.

**Export Data:** Export data and setups of the last recorded oscilloscope shot in a csv file.

**Oscilloscope Settings** Switch to setup mask for channels, triggers, times and modes.

**Display Settings** is used to set scale, offset and color for the oscilloscope channels.

**Show/Hide:** Show and hide the oscilloscope channels.

**Show/Hide Cursor:** Two time cursors can be displayed for measuring the signals.

**Statistics Value:** This button opens a window that shows some statistics value for each channel. The calculation is between the two cursors. When both cursor are disabled then the calculations are over the whole oscilloscope shot.

### 2.7 Curves

With the curve tool, motor motion profiles can be easily created, joined, uploaded, downloaded and saved. **NOTE:** On B1100 the curve feature must be enabled with an access key.

![Image of curve tool interface](image)

The curve tool is divided into the edit and the download window. The edit window is used to generate, merge and modify curves with the following buttons:

- **New Curve** Starts the curve wizard, which guides through the curve generation.
- **Edit Properties** The properties of a selected curve, like name, time or stroke, can be modified.
- **Edit Curve Values** The curve points can be manually edited.
- **Join Curves** All selected curves are joined. A wizard will be started for defining the curve properties of the joined curve.

The download window is used to manage the curves, which are stored on the drive or have to be downloaded. Modifications in this window will show up the message “Curves have changed! Please download.” After pressing the download into Drive button the window and the drive will be synchronized.
**Upload Curves from Drive** All curves stored on the drive will be uploaded and displayed.

**Download Curves to Drive** The drive’s curve sector will be synchronized with the download window.

**Auto Numerate Curves** The curve ID, which must be unique, will be set automatically.

The maximum number of curves and number of sample points is defined as follows:

**Series B1100:**
- Max. 16 Curves
  - \#Curves * 70 Bytes + \#SamplePoints * 4 Bytes <= 2016 Bytes

**Series A110/C1100:**
- Max. 50 Curves
  - \#Curves * 70 Bytes + \#SamplePoints * 4 Bytes <= 32512 Bytes

**All other Series:**
- Max. 100 Curves
  - \#Curves * 70 Bytes + \#SamplePoints * 4 Bytes <= 65280 Bytes

### 2.8 Parameters

The drive’s parameters are displayed in a tree view.

The parameter service is controlled with the following buttons:

- **Show/Hide Details:** Additional information for each parameter, such as unique parameter ID (UPID), scaling, min/max value, can be displayed on demand.
- **Show UPID Browser:** When parameters are edited, which represent a UPID, this button will be visible. With this button, the UPID browser will be opened for an easy selection of a parameter.
- **OK:** The input value is confirmed with this button. Pressing the enter key has the same effect.
- **Cancel:** This button cancels the value typed in.
- **Read:** All parameters will be read and refreshed from the drive.

When a parameter is marked with a little red L (\(\text{L}\)), in front of the name, the parameter is a live parameter. A live parameter could be changed without stopping the firmware, all other parameter can only be changed when the firmware is stopped.

In the table below the columns of the parameterview are explained.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Raw-Data</th>
<th>Value (RAM)</th>
<th>UPID</th>
<th>Type</th>
<th>Scale</th>
<th>Offset</th>
<th>Min</th>
<th>Max</th>
<th>Default</th>
<th>Addr</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

0000h: UPID

**Raw Data:** is the Data like it is in the ROM without scaling and without the offset, in hexadecimal.
Value (RAM): stands in the RAM, this is the active value at the moment. This value is not editable in the LinMot-Talk. When the parameter is a live parameter then the RAM value will change when the user changes the ROM value in the LinMot-Talk.

UPID: Unique Parameter Identification
Type: is the type of the parameter, for example SInt32, UInt32, String ...
Scale: is the scale factor from the Raw Data to the Value.
Offset: is the offset that must be added to the Raw Data to receive the Value.
Min: is the minimal value that the parameter value could have.
Max: is the maximal value that the parameter value could have.
Default: is the value that the parameter has after defaulting the drive.
Attr.: The Attribut defines what are the rights of the user with this parameter. R means read, W means write, with RW is both possible.

When a parameter is selected and then the F1 button would be pressed, the Object Inspector starts up. In the Object Inspector are some informations about the parameter. If there is a blue more in the window it is a link to the documentation where it has more information about this parameter and his functionality.

2.9 Variables

The drive’s variables, which can be watched, are arranged in different functional groups. The MC SW overview group contains the most used variables.
The variable service is controlled with the following buttons:

- **Show/Hide Details**: Additional information for each parameter, such as unique parameter ID (UPID), scaling, min/max value, can be displayed on demand.
- **Read Variable**: Reads the selected variable from the drive once.
- **Write Variable**: Writes the selected variable to the drive.
- **Read All Variables**: Reads from the drive all variables of the section once.
- **Read All Variables Cyclically**: Reads from the drive all variables of the section cyclically.
- **Remove (Del)**: Removes the selected variable from the list.

The following buttons are only used in special cases.

- **Edit Properties**: The parameter properties can be displayed and changed.
- **New … Variable**: In a new generated variable section a new variable can be defined. This is a drop-down menu, which supports different variable types.
- **New Bit Variable**: In a new generated variable section a variable of the type bit can be defined.
- **New String Variable**: In a new generated variable section a variable of the type string can be defined.
- **New Float32**: In a new generated variable section a variable of the type float32 can be defined.
- **New With UPID**: In a new generated variable section a variable can be added by using the UPID from the appropriate parameter.
Under “User Defined” any variables or parameters can be arranged together. Typically the variables are selected via UPID. It is also possible to drag and drop them from the parameter or variable section.

2.10 Command Table

The drive supports the command table (CT) functionality, which means a set of up to 255 motion commands (31 commands for B1100GP and B1100VF series drives, on B1100PP CT is not supported) can be stored in this table. An example of is shown in the following picture:

A big variety of commands can be set in this tables, such as motion commands, conditions, sequence directives, parameter access, …

This makes the CT to very powerful functional unit. The CT entries can be accessed (executed) via digital inputs (on X6) or via interface software.

The CT tool has the following editing elements:
- **Entry ID** indicates the CT entry, which is being edited.
- **Entry Name** is a descriptive string of max. 16 characters
- **Motion Command Category** the available commands are fitted into groups for keeping a better overview
- **Motion Command Type** specifies the command to be executed in this entry.
- **Auto execute new command on next cycle** when selected, on the next cycle the entry specified under “ID of Sequenced Entry” will be executed. This gives the possibility of defining cycles, simple logical sequences.
- **ID of Sequenced Entry** defines the CT entry executed on the next cycle when “Auto execute new command on next cycle” is activated.
- **Apply** writes the edited values into the entry.
- **Upload from Drive** reads and displays the entire command table from the drive.
- **Download to Drive** writes the edited table (from the PC) to the drive.

An application example of the CT can be found in the motion control software user manual (Usermanul_MotionCtrlSW_E1100.pdf).

2.11 Access Codes

On the drive, special features or customer specific applications are protected by a software key. This means, a key must be activated by an access code, which is drive specific (pinned to the serial number). Under Drive\Set Access Code\ the following window will open:
A maximum of four keys can be set on the drive. Under Active Keys all valid installed keys are listed (key value and access code).

A new key can be set by selecting the key name and defining the value and access code. With the write button, the key and access code are written to the drive. As soon as the drive has rebooted (click the Activate button) the new key will be active, if the access code fits.

Please note: Access codes are drive specific. They cannot be copied from one drive to another.

From LinMot-Talk version 6.10 you can also enable a technology function in "evaluation mode". This allows you to use the function for a time of 4 hours after which the drive goes into error state. Under Variables\OS SW Keys you can read the remaining evaluation time (minimum value between all keys in evaluation mode). If a drive supports the evaluation mode the tab "Set Trial Key (Evaluation Mode)" will be visible. Choose the technology function to be evaluated and press the "Set Trial Key" button to start the evaluation. In the "Active Keys" window the technology function in evaluation mode appears with a value of the access code set on FFFFFFFFh.
## Set Access Code

### Active Keys:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Access Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key1</td>
<td>5A93h - TF-Force Control</td>
<td>4CA91CACb</td>
</tr>
<tr>
<td>Key2</td>
<td>5A95h - TF-Process Monitoring</td>
<td>FFFFFFFFh</td>
</tr>
<tr>
<td>Key3</td>
<td>0000h - No Key</td>
<td></td>
</tr>
<tr>
<td>Key4</td>
<td>0000h - No Key</td>
<td></td>
</tr>
</tbody>
</table>

### Set Key Access Code

<table>
<thead>
<tr>
<th>TF-Process Monitoring</th>
<th>Set Trial Key</th>
</tr>
</thead>
</table>

[button] Close
The following table shows on which drives the different functions are available:

Legend:
- **S**: Standard Function
- **TF**: Technology Function, can be enabled with key
- **NA**: Function not available

<table>
<thead>
<tr>
<th>Technology Functions</th>
<th>Curve</th>
<th>Force Control</th>
<th>Process Monitoring</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1100</td>
<td>S</td>
<td>TF</td>
<td>NA</td>
</tr>
<tr>
<td>B1100</td>
<td>TF</td>
<td>TF</td>
<td>NA</td>
</tr>
<tr>
<td>B1150ML</td>
<td>TF</td>
<td>TF</td>
<td>NA</td>
</tr>
<tr>
<td>E1200</td>
<td>S</td>
<td>TF</td>
<td>NA</td>
</tr>
<tr>
<td>E1400V2</td>
<td>S</td>
<td>TF</td>
<td>NA</td>
</tr>
<tr>
<td>A1100</td>
<td>S</td>
<td>TF</td>
<td>NA</td>
</tr>
<tr>
<td>C1100</td>
<td>S</td>
<td>TF</td>
<td>NA</td>
</tr>
<tr>
<td>C1200</td>
<td>S</td>
<td>TF (Evaluation Mode Supported)</td>
<td>TF (Evaluation Mode Supported)</td>
</tr>
<tr>
<td>C1400</td>
<td>S</td>
<td>TF</td>
<td>NA</td>
</tr>
<tr>
<td>D1400</td>
<td>S</td>
<td>NA</td>
<td>NA</td>
</tr>
</tbody>
</table>
# 2.12 Information Window

The Information Window is only visible when it has a message inside and it is activated. It could activated with the Information Window button in the Tool button bar. The window can show the messages from the list below.

<table>
<thead>
<tr>
<th>Motor Wizard:</th>
<th>The MotorWizard was not used, the Motor is only defined by PnP.</th>
<th>The Motorwizard defines more Parameter then the PnP, this Parameters are not set now. This message will be cleared when the user finishes the Motor Wizard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oscilloscope:</td>
<td>An Oscilloscope has new data.</td>
<td>This message shows that an oscilloscope has finished, it will be cleared when the user goes to an oscilloscope</td>
</tr>
</tbody>
</table>

# 3 Quick Start Guide

This chapter helps step by step to set up a system using servo drive and the LinMot-Talk configuration software. Cabling drive is described in the following chapters:

- Cabling E1100
- Cabling E1200
- Cabling E1400
- Cabling B1100
- Cabling B8050-ML
- Cabling A1100
- Cabling C1100
- Cabling C1200
- Cabling M8000
3.1 Cabling E1100

The following picture shows the connectors on the drive used for a first commissioning (with PC only).

- **X1** Motor Power Supply (X1)
- **X2** Motor Phases (X2) (if present, otherwise on X3)
- **X3** Motor Signals (X3)
- **X4** Signal Supply (X4)
  - Pin1: GND
  - Pin2: +24VDC
  - Pin12: SVE (if present)
- **X5** RS232 to PC (X5)
  - Pin2: RS232TX
  - Pin3: RS232RX
  - Pin5: GND
  - Use a 1:1 cable to the PC

- **X1** Motor Supply, use 48..72 VDC (between PWR+ and PGND).
- **X2** Motor Phases: if this connector is not present, connect the motor on X3 only.
- **X3** Motor signals: if motor has a DSUB-9 connector, connect it directly, otherwise use an adapter to DSUB-9 or wire the phase lines to X2.
- **X4** For a commissioning with the PC it is necessary to wire only the Pin1 (GND), Pin2 (+24VDC) and, if present, Pin12 save voltage enable (SVE, +24VDC).
- **X5** RS232: The cable between the LinMot drive and PC must be DSUB-9 F/F, 1:1 (X modem). If the PC has no COM port available, use the USB to RS232 converter (LinMot article number 0150-2473).
3.2 Cabling E1200

The following picture shows the connectors on the drive used for a first commissioning (with PC only).

- **X1** Motor Power Supply (X1)
- **X2** Motor Phases (if present, otherwise on X3)
- **X3** Motor Signals (X3) (DSub 9f)
- **X4** Signal Supply (X4)
  - Pin1: GND
  - Pin2: +24VDC
  - Pin12: SVE (if present)
- **X15/X16** Configuration Ethernet
- **X19** RS232 to PC (X19)
  - Pin3: RS232RX
  - Pin5: GND
  - Pin6: RS232TX

- **X1** Motor Supply, use 48..72 VDC (between PWR+ and PGND).
- **X2** Motor Phases.
- **X3** Motor Signals. (Note: the motor phases are not present on this connector. Thus wire the motor phases in any case to X2).
- **X4** For a commissioning with the PC it is necessary to wire only the Pin1 (GND), Pin2 (+24VDC) and, if present, Pin12 save voltage enable (SVE, +24VDC).
- **X15/X16** Ethernet: Use a standard RJ45 patch cable to wire to the LAN.
- **X19** RS232: Use the RS232 PC configuration cable (LinMot article number 0150-2143) to connect your PC via RS232. If the PC has no COM port available, use the USB to RS232 converter (LinMot article number 0150-2473).
3.3 Cabling E1400

The following picture shows the connectors on the drive used for a first commissioning (with PC only).

- **X2** Motor Phases.
- **X3** Motor Encoder Signals.
- **X4** For a commissioning with the PC it is necessary to wire only the Pin1 (GND) and Pin2 (+24VDC).
- **X15/X16** Ethernet: Use a standard RJ45 patch cable to wire to the LAN.
- **X19** RS232: Use the RS232 PC configuration cable (LinMot article number 0150-2143) to connect your PC via RS232. If the PC has no COM port available, use the USB to RS232 converter (LinMot article number 0150-2473).
- **X30** Motor Supply, use 3x400 / 3x480VAC 50/60 Hz
- **X33** Safety Relays: For the safety relays use a separate +24VDC supply. For a commissioning it is necessary to wire both Ksr+ (X33.4 and X33.8) to +24 VDC and both Ksr- (X33.3 and X33.7) to GND.
3.4 Cabling B1100

The following picture shows the connectors on the drive used for a first commissioning (with PC only).

- **X1** Motor Supply, use 48..72 VDC between (PWR+ and PGND).
- **X2** Motor Phases
- **X3** Motor signals: if motor has a DSUB-9 connector, connect it directly, otherwise use an adapter to DSUB-9 or wire the phase lines to X2.
- **X5** RS232: The cable between the LinMot drive and PC must be DSUB-9 F/F, 1:1 (X modem). If the PC has no COM port available, use the USB to RS232 converter (LinMot article number 0150-2473).
- **X14** For a commissioning with the PC it is necessary to wire only the Pin13 (DGND) and Pin25 (+24VDC).
3.5 Cabling B8050-ML

The following picture shows the connectors on the drive used for a first commissioning (with PC only).

- **X23 RS232**: The cable between the LinMot drive and PC must be DSUB-9 F/F, 1:1 (X modem). If the PC has no COM port available, use the USB to RS232 converter (LinMot article number 0150-2473).
- **X24**: Use a 24V switched power supply.

![Diagram of drive connectors]

- **RT ETH Out (X18)**
- **RT ETH In (X17)**
- **RT Bus LED**
- **RT Bus ID (S1, S2)**
- **State LED**
- **RS232 Config to PC (X23)**
  - Pin2: RS232TX
  - Pin3: RS232RX
  - Pin5: GND
  - Use a 1:1 cable to the PC
- **Supply +24VDC (X24)**
- **MC Link 1 (X25)**
- **MC Link 2 (X26)**
- **MC Link 3 (X27)**
- **MC Link 4 (X28)**
3.6 Cabling A1100

- **X2** Motor Phases.
- **X3** Motor Signals.
- **X19** RS232: Use the RS232 PC configuration cable (LinMot article number 0150-3544) to connect your PC via RS232. If the PC has no COM port available, use the USB to RS232 converter (LinMot article number 0150-2473).
- **X40** Wire Pin1 (GND) and Pin2 (+24VDC) for signal supply, and for motor supply, use 48..72 VDC for PWR+ on Pin4 and PGND is on Pin3. (Linmot provides a connector with the crimped 1.5m long wires as a product under the article number 0150-3545.)
3.7 Cabling C1100

- **X1** Motor Supply, use 48..72 VDC (between PWR+ and PGND).
- **X2** Motor Phases.
- **X3** Motor Signals. (Note: the motor phases are not present on this connector. Thus wire the motor phases in any case to X2).
- **X4** For a commissioning with the PC it is necessary to wire only the Pin1 (GND) and Pin2 (+24VDC).
- **X7-8** RS485: Use the USB to RS485 converter (LinMot article number 0150-3356) to connect your PC. Switch S4.1 has to be set to 'ON' (supported with FW >=6.9). Multidrop connections are not supported, only point-to-point connections are possible.
- **X19** RS232: Use the RS232 PC configuration cable (LinMot article number 0150-2143) to connect your PC via RS232. If the PC has no COM port available, use the USB to RS232 converter (LinMot article number 0150-2473). Switch S4.1 has to be set to 'OFF'.
- **X33** Safety Relays: The connector X33 is only present for 1S safety functionality. For the safety relays use a separate +24VDC supply. For a commissioning it is necessary to wire both Ksr+ (X33.4 and X33.8) to +24 VDC and both Ksr- (X33.3 and X33.7) to GND.
- **S4** S4.1 selects the communication channel used for LinMot-Talk communication. OFF (Default): RS232 on X19, ON: RS485 on X7/8. If the installed interface is LinRS, the interface will automatically use the other channel. (supported with FW >=6.9)
3.8 Cabling C1200

- **X1** Motor Supply, use 48..72 VDC (between PWR+ and PGND).
- **X2** Motor Phases.
- **X3** Motor Signals. (Note: the motor phases are not present on this connector. Thus wire the motor phases in any case to X2).
- **X4** For a commissioning with the PC it is necessary to wire only the Pin1 (GND) and Pin2 (+24VDC).
- **X19** RS232: Use the RS232 PC configuration cable (LinMot article number 0150-2143) to connect your PC via RS232. If the PC has no COM port available, use the USB to RS232 converter (LinMot article number 0150-2473).
- **X33** Safety Relays: The connector X33 is only present for 1S safety functionality. For the safety relays use a separate +24VDC supply. For a commissioning it is necessary to wire both Ksr+ (X33.4 and X33.8) to +24 VDC and both Ksr- (X33.3 and X33.7) to GND.
3.9 Cabling M8000

- **X3 Motor**: This is the only connector to the motor, it includes the phases and signals.
- **X19 RS232**: Use the RS232 PC configuration cable (LinMot article number 0150-2143) to connect your PC via RS232. If the PC has no COM port available, use the USB to RS232 converter (LinMot article number 0150-2473).
- **X33 Safety Relays**: The connector X33 is only present for 1S safety functionality. For the safety relays use a separate +24VDC supply. For a commissioning it is necessary to wire both Ksr+ (X33.4 and X33.8) to +24 VDC and both Ksr- (X33.3 and X33.7) to GND.
- **X34 Motor Supply**: Use 48..72 VDC (between PWR+ and PGND). The Axis 1-4 and 5-8 are supplied separately.
- **X36**: For a commissioning with the PC it is necessary to wire only the Pin1 (GND) and Pin2 (+24VDC).
3.10 Firmware Download

As the cabling is done correctly now, turn on the drive’s power and start up the LinMot-Talk software. Before using the drive the first time, the firmware has to be downloaded. Therefore press install firmware button to start the wizard. Choose the file “Firmware_Build20101126.sct” (or similar) and press “Open”. Then the wizard will start and guide through the installation.

In case of installing the firmware over ETHERNET, the service password is required. This is for safety reasons. Especially if there are a lot of drives accessible in the network, it can easily happen to confound them. Thus it is strongly recommended to set a password. By default no password is set. If the password is unknown, the parameters can be set to default by hex switches, see 4.1. Installing the firmware over ETHERNET is only possible on drives with a separate Config Ethernet (E1200 and E1400). Installation over RT Ethernet is not possible.

According to the drive type, different interfaces and application software can be selected. The following tables show the compatibility of drive type, interfaces and applications.

Legend:
- D: Programmed as default
- X: Can be selected
- P: Planned
- GW: Gateway Software
- 6.3: Until Software Build 6.3
- ML: Motion Link Version

<table>
<thead>
<tr>
<th>DriveType/Interface/Applications</th>
<th>D</th>
<th>X</th>
<th>D</th>
<th>D</th>
<th>X</th>
<th>X</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1150-GP</td>
<td>X</td>
<td>X</td>
<td>D</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C1150-GP</td>
<td>X</td>
<td>X</td>
<td>D</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>C1150-DS</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>C1150-EC</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>C1150-PD</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>C1150-PN</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>C1150-SE</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>C1250-DS</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>C1250-EC</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>C1250-IP</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>C1250-LU</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>C1250-PO</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>C1250-PL</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>C1250-PN</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>C1250-SC</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>C1250-SE</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>E1200-GP</td>
<td>X</td>
<td>X</td>
<td>D</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>E1200-PO</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>E1200-PL</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>E1200-PN</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>E1200-SC</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>E1200-SE</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>E1400-GP V2</td>
<td>X</td>
<td>X</td>
<td>D</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>E1400-PO V2</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>E1400-PL V2</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>E1400-PN V2</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>E1400-SC V2</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>E1400-SE V2</td>
<td>D</td>
<td></td>
<td></td>
<td>D</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
3.11 Login

When successfully finished downloading the firmware, login with "File/Login..." or with a double click on Project in the project tree window, then select the appropriate port and press ok. A login info window will appear showing the login progress.

When logged in you will find the following window:

The Object Inspector window can be dragged away or closed. It can be reopened with F1.

By login into a Drive without installing firmware before, it is possible that the firmware on the drive may not have the same version as LinMot-Talk. In this case it is possible to download the correct files to login. This is described in the chapter downloading Olderreleases.

3.12 Downloading Olderreleases

After installing LinMot-Talk, it has the possibility to install the actual version and the version before on a drive. The same is with login on a drive. LinMot-Talk can login on a drive that has the firmware on the actual...
version or one version before. For example with a LinMot-Talk 6.9 it is possible to login on drives with firmware 6.9 and 6.8.
To login on firmware or install firmware with older version, it is possible to download the files from the internet. To download the older firmware from the internet there are two possibilities, one is the manual downloading the other downloading by login. Manual downloading is recommended when more then one older versions are needed, or for installing a older version on a drive. Downloading by login is recommended when you have a drive with older firmware and you want to login on it. If there are Problems to connect the update server look in the chapter Problems with the update function.

3.12.1 Manual Downloading

In the Help Menu under Update Functions is the Option Download Older Releases.

After click on Download Older Releases the following window is showed.

The window shows a list of all version they are possible to download. The versions with the grey text are already installed on the computer. The versions with the black text are not yet on the computer. Select the needed version an click on the OK button. LinMot-Talk will connect to the server and download the selected versions. For this process the computer needs a connection to the internet. For installing the downloaded version on a drive the olderreleases folder is on the path C:\Users\USERNAME\AppData\Local\LinMot\LinMot-Talk X.Z - Build YYYYMMDD\Firmware\OlderReleases.
3.12.2 Downloading by login

By login on a drive with a firmware version that is not on the computer yet, the following dialogue will be shown.

By clicking on the "Check for compatible version" button, LinMot-Talk search the correct files on the server and download them. When it finished in the text is written if the download was successful and after clicking the OK button, the LinMot-Talk ask if it should start the login process again.

3.13 Scanning CAN Bus

When one or several drives are linked with CAN bus for configuring, it can be very helpful to scan the CAN bus for linked drives automatically. Thus, it is not necessary to know all node IDs. Under \File\Scanning (with CANusb) a list of the present drives will be displayed:

With just one click the LinMot-Talk software will log in to all drives.
3.14 Scanning Ethernet

When one or several drives are linked with Ethernet for configuring, it is helpful to scan automatically for linked drives. Thus, it is not necessary to know all node IP addresses. Under File→Scanning (via Ethernet) first the interface has to be selected (network link).

With the radio button Group Number could be activated a scan for a special drive group. The list will only display the drives with the group number, like the number in the text field. In the drives this number is saved in the parameter with the name Net Group and the UPID 0078h.

A list of the present drives will be displayed like in the picture below. With just one click the LinMot-Talk software will log in to all drives. The colored markings have the following meaning:

- Green: The drive is ready to log in.
- Grey: You are already logged into this drive.
- Red: Another instance is logged into this drive (other user or other interface).

The default mode for acquiring an IP address is via DHCP. If no servers on the connected network respond, the drive switches to the IPv4 Link-Local addressing scheme (also known as APIPA on Windows systems). This way the drive automatically assigns itself an address within the range of 169.254.0.1 through 169.254.255.254 (Subnet Mask 255.255.0.0).

Please note that this process can take up to a minute until a valid address is assigned to the drive this way.
3.15 Motor Wizard

As no motor is defined, the next step is to start the motor setup wizard. Press the button and the following window will appear:

As we want to configure a LinMot Motor we choose “LinMot Linear Motors” and press Open. Then we choose the stator family like “PS0x-23x” and then the stator subfamily like “PS01-23x160x”. Select the actuator type you have connected to the drive, then press Open.

If it is not possible to find the correct file, it is possible to update the motor files. This is described in the chapter update motor files.

3.15.1 Actuator Selection

The following steps will show forms including drawings and descriptive texts. The first step is to define the stator and slider.
The derived settings show information about the complete motor type, article numbers and the most important technical data. The change of the positive moving direction is supported since release 6R7 and only for motors with PnP version V3S2 and higher. Motor with PnP version V3S1 do not work with changed positive moving direction. Be also aware in case of exchange!
3.15.2 Drive Settings

The next step is to choose a drive name and if it is possible a regeneration resistor.
3.15.3 Extension Cable Setup

Longer extension cables will have an effect to the motor's phase resistance. In step 3 can be defined two cable segments.

![Motor Wizard](image)

**First Extension Cable Segment**
Type: KO5
Length: 2 m

**Second Extension Cable Segment**
Type: No Extension Cable

The ohmic resistance of extension cables can be quite high in relation to the motor's phase resistance. If the firmware knows the total ohmic resistance it can optimize the current control loop to the load. If there are extension cables used in the application, then the first segment(s) should be defined here. The cable piece that comes directly out of the motor is negligible.

<table>
<thead>
<tr>
<th>Derived Settings</th>
<th>Value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motor Phase Resistance</td>
<td>4.8 Ohm</td>
<td></td>
</tr>
<tr>
<td>Cable Resistance</td>
<td>0.14 Ohm</td>
<td></td>
</tr>
<tr>
<td>Total Resistance</td>
<td>4.94 Ohm</td>
<td></td>
</tr>
</tbody>
</table>
3.15.4 External Position Sensor System

The next hardware setup step is to define an external position sensor system (if present). For E1100 drives can be chosen between none, incremental AB(Z) and analog sine/cosine 1Vpp. For B1100 drives can be chosen between none, incremental AB(Z) and AB encoder simulation.
### 3.15.5 Feed Forward Parameters

With step 5 the feed forward parameters are set up. Depending on the moving mass, additional load mass, friction and orientation. Under the derived settings the influence can be watched.
3.15.6 PID Position Controller

With the next and last step the position drive’s parameters will be set up:

It is recommendable to start with the default soft settings, because the parameters can be changed any time later on (by restarting the motor wizard or by setting in the parameter tree directly). With the soft parameter setting, PID values will be quite low such as the motor is low noise and the position is not controlled very stiffly.

The stiff parameter set tends to more noise and more power consumption of the motor, but the position will be controlled harder.

In both settings, the I Gain is set to zero, which means a steady-state deviation from the desired position can occur. When using the I Gain, the position controller may tend to swing.

The Noise Filter option is to reduce the noise from the position feedback sensor at standstill. For finding the best set of PID parameters, the system has to be optimized iteratively. There is no general way of how to optimize the settings, because different goals can be achieved such as position accuracy, power minimization, noise reduction, ...
3.15.7 Homing 1

The next step is to define the homing procedure.

The most frequently used homing mode is “Mechanical Stop Negative Search”. In this case the slider will move with the notch towards the stator’s front end (where no cable is). Other modes support homing on home switches, limit switches, indexer inputs or some combinations of those.
3.15.8 Homing 2

Step 8 is to define the slider home position. This is for the motor and drive the most important value. It defines the home position, where the slider is positioned relative to the stator. This defines how far the motor can move in each direction.

![Motor Wizard]

**Step 8/9: Homing II**

**Distance from Stator End to Slider End at the Home Position**

![Diagram]

**Distance A**

<table>
<thead>
<tr>
<th>Value</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>mm</td>
</tr>
</tbody>
</table>

**Distance B**

<table>
<thead>
<tr>
<th>Value</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>154</td>
<td>mm</td>
</tr>
</tbody>
</table>

The drive needs to know the physical position of the slider relative to the stator. Please determine either distance A or distance B when the motor stands at the Home Position (mechanical stop or switch). Then enter the corresponding value. The other value is calculated by the software. If the slider end is inside the stator tube, then you have to give your entry a negative sign.

<table>
<thead>
<tr>
<th>Derived Settings</th>
<th>Value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slider Home Position</td>
<td>10 mm</td>
<td>Corresponds to distance A</td>
</tr>
</tbody>
</table>
3.15.9 Homing 3

With the last wizard step the user’s coordinate system can be defined.

At the end, press finish. If the firmware on the drive is still running, an appropriate message will be shown. All parameters will now being written to the drive.

The motor wizard can be run several times, e.g. to setup an external sensor, to change the load setup or to change the motor type. When rerunning it, at the end will be shown a list of parameters, which will be changed.
3.16 Unit System

For LinMot rotary Motors and the rotary part of PR01 motors in the motor wizard it has a special page. This page is to choose the unit system. The unit system is only in the LinMot-Talk active and has no effect to the drive. There are two unit systems. One is a Linear system the position is displayed in ‘mm’, the other system is a rotary system especially for rotary motors. The position is in this case displayed in ‘°’.

In the Page Number 5 Position Feedback, there is one parameter called “1 Revolution”. In the Linear unit system, this parameter says how many mm represent one revolution. In the rotary unit system, this parameter says how many ticks (one bit of the position in the motioncontrol software) are a revolution. In both cases, it has two recommended possibility. If the parameter has a multiple of 360 the numbers are well represented. Otherwise if the parameter has a value $2^n$ or in linear case $2^n \cdot 100nm$ the position of the motor is on 0 position the same also after an overflow of the position $\left(0 \rightarrow 2^{31} \rightarrow -2^{31} \rightarrow 0\right)$.

Attention:
For LinMot rotary Motors (EC02) it is important, that the value in this parameter is divisible by 4. That means $x \cdot 4$ or $x \cdot 4 \cdot 100nm$.
For the rotary part of the PR01 motors it is important, that the value in the parameter is divisible by 12. That means $x \cdot 12$ or $x \cdot 12 \cdot 100nm$. 

Motor Angle to Position Ratio

Base of Angle Measuring: Sine/Cosine Sensor

1 Revolution = 524288 Ticks:

Positive Counting Direction: Clockwise

External Position Measuring System (optional)

Sensor Type: No Sensor

Power Up Position Recovery

Mode: X3 Single Turn Position

Home Position (HP): 0

<table>
<thead>
<tr>
<th>Derived Settings</th>
<th>Value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commutation Period</td>
<td>131072 °</td>
<td></td>
</tr>
</tbody>
</table>
3.17 Update motor files

To update motor files click on "Check for new Motorfiles" in the Help Menu under Update Functions.

The following window will be shown.

![Motor files update window](image)

The last update shows the date of the last update performed on this computer. By clicking the "Check for Updates" button LinMot-Talk looks for the updates since the date of the last updates. All older updates will be ignored, because this updates are handled before. With the button "Reset Date", it is possible to reset this update date and LinMot-Talk will show all updates after clicking on the "Check for Updates" button. After click on the button "Check for Updates" button LinMot-Talk make a list with all new motor files. It is possible to choose the files they will be updated. When a file is not choosen, in a new update process it will not showed because then it is an update before the last update date.
Each motor file has a date on which it was created. With this date it is possible to see how old your motor files are. With the option All, all motor files from the server will be downloaded. This option is normally only possible if the update date has been previously reset.

After choosing the motor files they should be updated, the update will be started by clicking on the Ok button. When the window disappears, the updates are complete.

3.17.1 Adding a motor repository

It is possible to add another source for motor files. This other source can be from a third party supplier. The NTI AG does not check other sources, that means the customer himself is responsible for this source and the parts that LinMot-Talk downloads from this source.

In the motor files update window is a Add Repository button when the advanced check box is checked. After clicking on this button the following window will be shown.
To add a repository the following parts are needed:

- **Repository Name** is the name for selecting this repository in the motor files update window
- **URL** is the path to the source of the repository, this should be an internet address
- **Username** is used by LinMot-Talk to login to the repository
- **Password** is used by LinMot-Talk to login to the repository
- **Update Date** is not used to add a repository but the functionality is described in the [chapter update motor files](#)

### 3.17.2 Problems with the update function

When LinMot-Talk can not connect to the server, it shows an error message. In the table below are some possible cases for this error.

<table>
<thead>
<tr>
<th>Case:</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Computer has no connection to the Internet</td>
<td>Connect the Computer to the Internet.</td>
</tr>
<tr>
<td>Firewall blocks the TCP port 3690</td>
<td>LinMot-Talk uses an SVN client with a communication on the TCP port 3690 to download the data. Open this port for LinMot-Talk.</td>
</tr>
<tr>
<td>The update server is not online</td>
<td>Try the download later.</td>
</tr>
</tbody>
</table>

If there is no way to connect the update server, there is an other possibility to get the newest Motorfiles or get the Older releases. On the LinMot homepage, under download LinMot-Talk, are a Motor and an Older releases packages to download. Unzip and save this packages on the computer or somewhere in the network. LinMot-Talk can not work with the ziped packages. Change the Update Option in LinMot-Talk from Server to Local.
LinMot-Talk ask for the path of the packages. If both packages are needed, they must be on the same location. After that, LinMot-Talk try to update from the local path. In the error message when connecting the server, the button 'Change to local Package' directly changes the update option. It is possible that the packages have an older version then the data on the update server. Be careful the Olderreleases package is more then 1 GB.

3.18 Continuous Curve Mode

We want the motor to run a curve cyclically (The easiest, but not so informative way to run the motor would be the VAI 2 Pos Continuous mode). The drive is set to continuous curve mode by selecting “Continuous Curve” under \Motion Control SW\Motion Interface\Run Mode Settings\RunMode Selection in the parameter tree.

NOTE: For enabling the curve feature on B1100 drives, it is necessary to set an access key.
The second parameter to be set is to define which curve has to be run. Set the parameter “Curve ID” to 1 under \Motion Control SW\Motion Interface\Time Curve Settings\.
Before running the curve, it is advisable to define the curve we want to run.

### 3.19 Defining Curves

Curves can be easily defined with the curve wizard. For this example we will define two sine curve forms over a stroke of 50mm out and in with different speeds, which will be joined together.

Now, step by step: Open the curve tool by clicking the “Show Curves” button in the tool button bar. Then press the “New Curve” button to start the curve wizard.
As we want to define a curve in position vs. time mode we can keep the default selection and press the next button.

In this mask, we will set the curve ID to 2 (we will have the merged curve with ID 1 at the end) and as name we set e.g. “SineOut”. The end point is placed at 50mm. With “Next” the wizard will show some curve data:

The next and last mask proposes a number curve setpoints. It is advisable to accept this proposal.
with "Finish" the first curve is defined. The curve will be displayed as follows:

We will now define curve going back. So we start the curve wizard again and define under curve settings the following:
Set curve ID to 3, Curve Name to “SineIn”, Curve Length to 500ms, Start Point to 50mm and End Point to 0mm. Click twice “Next” and then “Finish”.

Now we have defined the two curve segments and will join them together. Select the two curves then press the “Join Curves” button. The curve settings mask for the joined curve appears:
We will set the curve name to “SineOutIn” and make sure the curve ID is 1. The curve length is proposed as the sum of the curve segment times. Please consider the maximal number of curves and curve points indicated in chapter 2.6. Press “Next” and “Finish”. The curve for the continuous curve mode is now defined and has, according to the parameter settings, the curve ID 1. As we want to download the curves to the drive we select all the curves in the edit window and move them to the download window.

When double click the “SineOutIn” Curve the joined curve is shown:
Now the curves must be downloaded to the drive. Therefore press the “Show Curves” button and then the “Download Curves into Drive” button. Then a warning comes up which has to be confirmed and the progress window will display the actions taken to download the curves.

### 3.20 Control Status

As we have defined now all parameters and curves, we will let the motor running. For this time, we will take over the interface control from the PC. So we are interface-independent. Switch to the control panel with the button, then press the start button (starting the drive’s firmware) and wait until the control status panel is updated and looks the following:
Now we will fetch the control over the “Switch On” and the “Home” flags.

Now turn off and turn on again the “Switch On” flag, this is because of the auto start prevention. At this time, the motor will be powered and position controlled at the actual position. Set the “Home” flag and the motor will initialize against the inner hard stop.

When the motor stands still, clear the “Home” flag and the motor will run the curve continuously. Detailed information about the MC software’s state diagram can be found in the MC software manual.

### 3.21 Oscilloscope

The oscilloscope is a very useful tool for tuning the motor. The LinMot-Talk software has defined a default oscilloscope, which samples the actual position, demand position, position difference and demand current. When clicking on the “Show Oscilloscope” button, the focus will be set to the default oscilloscope. We
could start the oscilloscope now with the start button 🕳️. The recorded data will be read out from the drive and displayed. That will look somehow like the following picture.

![Oscilloscope screenshot]

Possibly it is necessary to press button 📐 (fit view). Tuning the system would be started at this point. One possibility is by restarting the Motor Wizard and changing the load or control parameter, another one is to change the parameters directly in the parameter tree.

To change the oscilloscope settings use the button 🛠️.
3.21.1 Oscilloscope Settings

By clicking on the Oscilloscope Button, the following window will open.

In the Oscilloscope Settings window are three sheets: General, Trigger and Advanced.

General: Here the Oscilloscope channels will be configured. The Channel X check box activates/deactivates the channel. In the two combo boxes the variable is selected that will be recorded in this channel. The check box Is math channel activates/deactivates the math channel function for this channel, see below.

Trigger: Here the trigger will be configured. There is the possibility to configure two trigger A and B. Trigger A and B could be logical linked with and or or. For each trigger the trigger condition

Advanced:

3.21.1.1 General

Here the Oscilloscope channels will be configured.

- **Acquisition Mode**: Choose the possibility of single shot or continuous recording
- **Recording Time**: Is the time over one oscilloscope shot.
- **Channel X check box**: activates / deactivates the channel
- **Is math channel**: Defines the channel as a math channel, this gives the possibility to use mathematical functions on other channels.
- **Group**: Defines the variable group for the recorded variable in this channel
- **Variable**: Defines the variable recorded in this channel

If the function "Is math channel" for one channel is selected, there are three combo boxes for this channel. In the first box the mathematical function will be selected. The function of the other two boxes is depending on the mathematical function of the math channel. The list below describes the mathematical functions.
Addition: The channel shows the sum of the two channels they are selected in the two following combo boxes

Subtraction: The channel shows the difference between the two channels selected in the following combo boxes

Product: The channel shows the product of the two channels selected in the following combo boxes

Ghost: The channel shows a channel that is recoded in a other oscilloscope. The first following combo box defines the oscilloscope of the showed channel, the second the showed channel.

3.21.1.2 Trigger

On this sheet it is possible to define two trigger conditions. Group and Variable define the trigger variable, for each condition it is possible to define a different trigger variable. Under Event it is possible to choose the trigger event for the trigger condition.

Events:

- **Rising edge**: Triggers on a rising edge, that goes from below the value to the value or higher than the value.
- **Falling edge**: Triggers on a falling edge, that goes from up the value to the value or lower than the value.
- **Any edge**: Triggers on a edge, that goes to the value or through the value.
- **Greater than**: Triggers when the variable is greater than the value.
- **Less than**: Triggers when the variable is smaller than the value.
- **Greater or equal**: Triggers when the variable is greater then or equal to the value.
- **Less or equal**: Triggers when the variable is smaller then or equal to the value.
- **Equal**: Triggers when the variable is equal to the value.
- **Not Equal**: Triggers when the variable is not equal to the value.
- **Change**: Triggers when the variable changes the value. This trigger does not depend on the value that is defined in the oscilloscope settings.
- **Difference greater or equal**: Triggers if the elevation between two neighboring measuring points, of the variable, is greater than or equal to the value / ms.
- **Difference less or equal**: Triggers if the elevation between two neighboring measuring points, of the variable, is smaller than or equal to the value / ms.
- **ABS difference greater or equal**: Triggers if the absolute elevation between two neighboring measuring points, of the variable, is greater than or equal to the value / ms.
- **ABS difference smaller or equal**: Triggers if the absolute elevation between two neighboring measuring points, of the variable, is smaller than or equal to the value / ms.
- **Masked Bits = False**: Triggers if all set bits in the value, are false in the variable.
- **Masked Bits = True**: Triggers if all set bits in the value, are true in the variable.

3.21.1.3 Advanced

In advanced settings it is possible to define:

- **Pretrigger**: is defined in % of the recording time.
- **Delay**: Is the delay after trigger event when the recording starts. It is defined in absolute time.
- **Set recording time**: Attention changes in this section have influence to the recording time on the general sheet.
- **Sample period**: define the time between two neighboring measure points.
- **Number of samples**: defines the number of measure points per channel. The maximum of number of samples depending on the number and size of the measured variables. The maximum of number of samples with the current settings is showed behind the edit box with the number of samples
- **Preview function**: It draws an estimated graph during the measurement process. This function works only when the recording time is bigger then 10 s.

3.21.2 Display Settings

To change the display settings in the oscilloscope there are several possibilities. One is with the Fit-Buttons and . For both buttons it is possible to push the numbers on the Keyboard on the same time of clicking on the button. When some numbers are pushed, the functionality of the buttons has only influence on
the channel with the same numbers. For example when somebody clicks on the Fit-Button and push on the same time number 2 and 3, only channel 2 and 3 will be fitted.

Fit view looks that every channel is showed optimized in the window of the oscilloscope. Every point of a channel is in the window, but it uses the most part of the window.

Fit view (same unit same fit) makes the same like fit view but the channels with the same units have the same scale. That means all points of all channels with the same unit are in the window and have the same scale.

An other possibility to scale the view is the mousewheel. With it, the Keyboard has also influence. The number make the same like by the fit-view buttons and when the ‘X’ is pushed then it scales only in X-direction. The same is with the ‘Y’ then it scales only in the Y-direction. By scaling without all channels, it scales also only in Y-direction.

The third possibility is with the Display Settings window. In this window it is possible to change the scale, offset and colour of each channel. It is possible to change the time scale. With the radio buttons Offset/Division and Min/Max it is possible to change the minimal and maximal values of the axes, instead of offset and scale.

This button changes how the curves are represented, only with a line, only with the measure points or with line and measure points.

In the tab print it is possible to add some UPIDs. This UPIDs will be written with their values in the comment when the oscilloscope window will be printed. With this function it could given out some information, for example some control parameters.

### 3.22 Continuous Two Point Mode

The easiest way to run the motor continuously is to set the VAI 2 Pos Continuous mode. In this mode the motor moves between the two positions Trig Fall and Trig Rise. The time the motor waits at the two positions is defined under “VAI 2 Pos Cont Settings”.

The minimal settings for this mode are shown next. First the mode has to be set:

And then the positions have to be set under “Trig Fall Config\Position” and “Trig Rise Config\Position”: 
This is all we have to configure. The speed, acceleration and deceleration can also be defined at this place in the parameter tree. The motor can now be started the same way as described under 3.18.

3.23 Export Configuration

When the drive settings are done, it is strongly recommended to save the complete configuration. This can be done under File à Export… or with by clicking on . First it will open the Save Config window. This window is to choose the drives, from them the config should be saved. There are the possibilities to select one drive or a group of drives. With out the Advanced Options the LinMot-Talk will read the empty (still not read) variables before it saves the configuration.

The selection Advanced Options opens the tree to select only parts of a drive. It can be selected for each drive different parts. The active drive is market green. To change the active drive only click on the new drive that should be active.
After that the file name dialog will open to choose the filename and the folder where the file should be saved. It is recommended to export all parts of a drive. For a configuration recovery, it is necessary to select the parameters, curves and command table. In case of a support request, it is recommended to save the configuration without the advanced options and all drives should be selected. Because then the supporters have all informations from the drive that they need.

### 3.24 Import Configuration

A configuration can be imported with File à Import… or with the button 🔄. First it opens a dialog window.

In this window, each configuration in the file has a line, in the combobox a drive could be selected. In this drive the configuration will be loaded. There are four possibilities of imports. They have the followed Symbols.

- not used
- open offline
- import to a drive with the same drivetype like the drivetype in the config
- import to a drive with another drivetype then the drivetype in the config. In this case, it can have some inconsistent parametertrees!
Two possibilities are always possible, not used and open offline. Not used means with this configuration nothing happens. Open offline means for this configuration an offline device will be created and the configuration will load in it. Each drive, on it the LinMot-Talk is logged in, could only selected in one line at the time.

In the green part on the right side of the window, it is possible to select the parts from the configuration, they will be imported to the drive. For each configuration, it has an only tree of parts. The shown tree is from the configuration that is green too. It is possible to import only some specific parts (e.g. curves or command table).

When opening a configuration to a drive, a compatibility list of the parameter trees will be shown. Then the selection of the importable parts will be shown.

### 3.25 Open Offline Configuration

A configuration can also be opened when no drive is present. Under File à Login/Open offline…

![Login](image1)

This is a very helpful feature for supporting problems.

### 3.26 Create Offline Configuration

For any supported drive a configuration can be created offline. Choose the menu item File/Create Offline…

![Create Configuration](image2)
The above window will be shown. Select the drive family first, then select the drive type, then choose the interface and application software. The software parts, which can be selected, are the same as when installing firmware to the drive. When created the configuration, the parameters will have their default values. The configuration can then be altered and saved the normal way.

### 3.27 Compare Parameters

Under Drive → Compare Parameters, there is a function, which allows to compare the settings between different drives.

![Compare Parameters](image)

This useful function works with online and offline configurations. There are different setups available, such as firmware instances (OS, MC, INTF and APPL) or parameter types (read only or writable). The parameter list can be saved as a *.pvl file (comma separated text file).
3.28 Portable App

When it is useful to have a runnable LinMot-Talk an USB-Stick or only in one folder, a portable app of LinMot-Talk can be created. Under Help->Update Functions the function Generate Portable App can be started. The following window will open.

With "Browse" it is possible to choose the path of a folder. If the path is typed manual, with checking "Generate the path if it does not exists" it is possible to generate a new folder for the Portable App. By clicking on the Ok button and the path is correct, the LinMot-Talk copy's all necessary files into the folder. It is recommended to update the motor files and get all used older releases from the LinMot-Server before generate a portable app.

The generation of a portable app takes some time, please be patient. On the shape of the mouse cursor, it is possible to see if the portable app is generated. When the cursor returns to its normal shape, the portable app is ready.

4 Trouble shooting

4.1 Setting all Parameters to Default Values

The following procedures to default the parameters are possible without LinMot-Talk. With LinMot-Talk it is possible to use the DEF button. This button is described in chapter Tool button bar.

E1100, E1200, E1400, B8050, MB8050, C1100-GP and C1250

All parameters of the SG3 and SG5 drives can be set to their default values without the use of the LinMot-Talk. This can be done according these steps:
1. Power off the drive.
2. Set the two ID switches to 0xFF.
3. Power on the drive, the Error and Warn LEDs will blink alternately at ~4Hz.
4. Set the two ID switches to 0x00.
5. Wait until the Warn and EN LEDs will flash together at ~2Hz.
6. Power off and on again.

B1100

On SG4 drives an image of the default parameters will be stored during the software installation. This image can be reloaded to the operating parameters. The procedure is the following:
1. Set the parameter with UPID 0x6085 to 0x0001.
2. Power off the drive.
3. Power on the drive.

The value of the parameter with UPID 0x6085 will be automatically cleared to 0x0000.

A1100
All parameters set to their default values without the use of the LinMot-Talk. This can be done according to these steps:
1. Power of the drive.
2. Set the DIP switch S5.2 to on.
3. Power on the drive, the Error and Warn LEDs will blink alternately at ~4Hz.
4. Set the DIP switch S5.2 to off.
5. Wait until the Warn and EN LEDs will flash together at ~2Hz.
6. Power off and on again.

### 4.2 Interface does not run

If the interface software (DeviceNet, CANopen, Profibus, LinRS) does not communicate there may be several reasons:
- Specific Interface Software not installed
- Switch S3.4 "Interface" on drive's bottom side must be set to "On". (In case of LinRS, this switch must be set to off when configuring over RS232, and set to on when running the LinRS interface).
- Parameter with UPID 2008h set to disable.
- Baud Rate and Node ID selection not correctly set (Parameters and/or ID switches on drive's front)

### 4.3 Stopping Firmware

When the same link is used for configuration purposes and from the interface (e.g. RS232 link and LinRS interface) it may not be possible to login with the LinMot-Talk software. In some cases, it should be possible to log in, e.g. to download new firmware.
On E1100 drives, the interface switch S3.4 can be set to off and after a power up the interface software should be deactivated and the configuration link should be free. If this does not help, or you are working with a B1100 drive, there is a script under File -> Open -> StopFirmware.sct, which keeps trying to stop the drives firmware while it is powered on. After a power up, within the first 2 seconds the interface can be prevented from starting.

### 4.4 Communication debug Window

To see the communication between the LinMot-Talk and the Drives, there is a debug window. In the menu, Tools – RSTelk Debug Window, it opens the debug window.

The debug window looks like in the picture below. To see the communication, it is necessary to check the checkbox “Enable Debug Mode”.
In the menu, Options – Save Debug Window Data, it is possible to enable the automatic save of the debug window.

If this is enabled, it is not necessary to have the debug window active. The data will be saved in files with the path: "C:\Users\username\AppData\Local\LinMot\LinMot-Talk6.6-BuildXXXXXXXX\Communication". The LinMot-Talk saves this data in 10 files. It saves the data cyclic and when it begins with a new file it overwrites the oldest one. Every time when the LinMot-Talk will be restarted this option is disabled.
4.5 Measures against cyber attacks

4.5.1 Firmware on the Drives

The firmware is loaded encrypted from the LinMot-Talk to the drives. The individual parts of the firmware are secured against modification by means of a checksum. If a checksum is not correct, this firmware part will not be started.

4.5.2 Configuration of the Drives

The configuration on the drives is not protected against changes. Because parameters can be changed (as a functional requirement) with a connected PLC, it cannot be excluded that parameters can be changed with randomly generated packets on the fieldbus. However, these packets would have to fit quite exactly (e.g. for an EtherNet/IP connection: IP address, UDP port and the commands).

A hash value (UPID 00A1h) is calculated over the configuration when the drive is started. This hash value can be read out when freshly installed. On each startup the configuration can be checked by comparing the hash values.

4.5.3 Restoring the correct State

If it is suspected that the firmware on a drive is not correct, the firmware can be reinstalled using LinMot-Talk. To be safe, re-download the LinMot-Talk software from the LinMot homepage, or restore it from a backup that is not contaminated with viruses.

To reset a configuration, a drive can be defaulted by the use of LinMot-Talk (Default Parameters). Afterwards, an old configuration can be loaded onto the drive.

It is recommendable to default all parameters before loading the configuration, as a configuration may not contain all parameters. (This is dependent from the settings when creating the configuration.)
Please visit [http://www.linmot.com/contact](http://www.linmot.com/contact) to find the distribution close to you.

Smart solutions are...